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[bookmark: _Toc131581897]Purpose
The procedures described in this document provide a means for guiding project staff in the proper creation of documentation requiring digital (electronic) signatures.
A digital signature, like a conventional handwritten signature, identifies the person signing a document. Unlike a handwritten signature, a digital signature is difficult to forge because it contains encrypted information that is unique to the signer and easily verified. 
To sign a document, you must have a digital ID. The digital ID contains a private key and a certificate, also known as a public key. The private key adds the digital signature, and the certificate that you share with people who use it to validate your signature. All users on the VA network, whether Federal employees or contractors, must have a PIV card, which contains a Digital Signature Key (DSK) to enable digital signatures and for encryption of e-mail. DSKs cannot be exported from the PIV card. 
[bookmark: _Toc131581898]Apply Digital Signatures to an Adobe Acrobat Document
Adobe Acrobat allows the convenient creation of documents that can be digitally signed.  A disadvantage to the use of Adobe Acrobat to create and manage documents with digital signatures is the licensing costs. The creator of the document must use Adobe Acrobat Professional. Those who sign the document only need Adobe Acrobat Reader.
When you apply a digital signature, Acrobat uses a hashing algorithm to generate a message digest, which it encrypts using your private key. Acrobat embeds the encrypted message digest in the PDF, along with details from your certificate, an image of your signature, and a version of the document at the time it was signed.
Note: Complete the following tasks as part of final preparation for artifact:
1. Resolve all changes and comments in the artifact file
2. Remove the ‘DRAFT’ watermark
3. Verify that all figures in the document are flat file (not layered) and have Alt text applied
4. Prepare signature lines for all required signers
5. Run a final Spell Check
6. Run required 508-compliance checks and resolve accessibility issues
[bookmark: _Toc131581899]Create a Form in Adobe Acrobat Professional DC
1. Create the document in Word
2. Save as Adobe PDF
[image: ]

[image: ]
3. [bookmark: _Hlk15391161]Select the Enable All Features button in the  Protected View pop-up window if it displays
[image: ]
4. [bookmark: _Hlk13841111]Select Tools in the toolbar
[image: ]

NOTE: If your document contains links:
a. [bookmark: _Hlk13823473]Select Edit PDF in the Create & Edit section
[image: ]
b. Select Add/Edit Web or Document Link selected from Link drop down menu
[image: ]
c. Choose a starting point, click the mouse, and drag to display a rectangle to define the Link field
[image: ]
d. Select Invisible Rectangle highlighted in Link Type drop down menu, and click the Next button
[image: ]
e. Type the URL in the Enter a URL for this link field and click the OK button 
[image: ]

NOTE: Repeat for all links you wish to add
5. Remediate the PDF for Section 508 conformance
6. Select Tools in the toolbar
[image: ]
7. Select Prepare Form from the Forms & Signatures section
[image: ]
8. Select the Change link adjacent to the Form field auto detection line if Form field auto detection is ON

[image: ]
9. Deselect the Automatically detect Form fields checkbox in the Preferences  pop up window, accept defaults, and then select the OK button
 [image: ]

10. Save your changes and click the Start button
[image: ]
11. [bookmark: _Hlk49344898]Select the Add a digital signature icon in the Prepare Form toolbar
[image: ]
12. [bookmark: _Hlk13823722]Choose a starting point, click the mouse, and drag to display a rectangle to define the Digital Signature field
[image: ]
13. Type a title for the field in Field Name area and click outside the field
[image: ]
14. Repeat these steps until you create all the desired Digital Signature fields
15. On the File menu, point to Save As Other, select Reader Extended PDF, then click Enable More Tools (includes form fill in & save)…
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTML1e3919e.PNG]
NOTE: Some versions of Adobe Acrobat do not require the PDF to be saved as a Reader Extended PDF.
16. The Enable Usage Rights in Adobe Acrobat Reader pop up window displays
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTML1577361.PNG]
17. Click the Save Now button to save the form
18. Navigate to a folder and click the Save button
19. Close Adobe Acrobat Pro DC
[bookmark: _Toc131581900]Digitally Sign a PDF Artifact Distributed Through E-Mail Using Adobe Acrobat Reader DC
1. Display the form
2. Select the Enable All Features button in the  Protected View pop-up window if it displays
[image: ]
3. Place your cursor in the desired field to select it
4.  Click to digitally display the Sign with a Digital ID dialog box
[image: ]
5. Select the appropriate Digital ID from the list with the radio button
 [image: ]

6. Verify that the selected certificate has not expired
 [image: ]

7. Click the Continue button in the Sign with a Digital ID window
 [image: ]

8. Click the Sign button
 [image: ]

9. The Save As pop up window displays
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTML1587fdf.PNG]

10. Click the Save button
11. A pop up window displays requesting the password or PIN associated to the certificate

12. Enter your PIN and click the OK button
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTMLae2fc9.PNG]

13. The digitally signed document displays
[image: ]

14. Save the document and circulate to all those whose signatures are required

NOTE: Whenever a team member displays the document, Adobe verifies the signatures

15. Select the icon for the Signature Panel at the top of the form
[image: ]

16. Select your signature from the Unsigned Signature Fields list in the Signatures panel
[image: ]

17. Place the cursor in the appropriate signature field
18. The next person signing the documents repeats the steps to sign the artifact 
[bookmark: _Toc131581901]Digitally Sign a PDF Artifact in a SharePoint Library with Adobe Acrobat Reader DC
1. Navigate to the SharePoint Library containing the form
2. Select the form in the library
NOTE: Only one person at a time can check out the file for signing. If the file is checked out, wait for the previous signer to finish before attempting to apply your own digital signature.
3. Check Out the form
4. Save a copy to your computer
5. Open the form
6. Select the Enable All Features button in the  Protected View pop-up window if it displays
[image: ]
7. In Acrobat Reader, navigate to the page in the document where you wish to add the digital signature
8. Select Tools from the menu bar
9. Click the Certificates icon in the Forms & Signatures section [image: ]
10. Select the Digitally Sign icon in the Certificates toolbar [image: ]
11. Choose a starting point, click the mouse, and drag to display a rectangle to define the Digital Signature field
Select the appropriate certificate in the Sign with a Digital ID window
12. Select the Continue button
13. Select the Sign button
14. The ActivClient box opens
15. Type your PIN into the field and click OK and Adobe Acrobat applies a digital signature certificate from your PIV card to your signature block
16. Save the file to your computer
17. Upload the file to the SharePoint library
18. When Adobe Reader prompts you to check the file back into SharePoint, select Yes
19. In the Check In box, type Digitally signed into the Version Comments field
20. Click OK
21. Adobe saves the file and uploads it back to the SharePoint document library so that other signers can check out the file to apply their digital signatures
[bookmark: _Toc131581902]Create a Form in Adobe Acrobat XI Professional
NOTE: Adobe Acrobat Professional is required to create a form that can be digitally signed.
1. Create the document in Word
2. Open Adobe Acrobat Professional
3. Select the Enable All Features button in the  Protected View pop-up window if it displays
[image: ]
4. Select Create Form from the Adobe Acrobat XI Pro menu
[image: ]
5. Select the From Existing Document radio button in the Create Form pop up window
6. Click the Next button
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTMLfc1633.PNG]
7. Select the Choose Another File radio button in the Existing Form pop up window and click the Browse button
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTML10461f2.PNG]
8. Browse to the Word document you wish convert to a form that can be digitally signed, click on it, and then click the Open button
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTML121d750.PNG]
9. Click the Continue button in the Existing Form window
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTML110e371.PNG]
10. A Progress pop up window displays
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTML1122fcb.PNG]
11. Click the OK button in the Form Editing pop up window that displays with the Word document converted to an Adobe Acrobat file
[image: ]
12. The document opens in Form Editing mode, and a Task pane opens on the right hand side of the page
[image: ]
13. Adobe Acrobat creates undefined fields throughout the artifact
[image: ]
14. Right click an undefined field and choose Select All from the drop down menu
[image: ]
15. Right-click the field again, point to the Edit menu, and click Delete
[image: ]
16. Click the Add New Field icon in the Tasks pane and select Digital Signature from the list
[image: ]
17. Choose a starting point, click the mouse, and drag to display a rectangle to define the Digital Signature field
[image: ]
18. Type a title for the field in Field Name area and press your Enter key on the keyboard
[image: ]
19. Repeat these steps until you create all the desired Digital Signature fields
[image: ]
20. Click the Close Form Editing button
[image: ]
21. On the File menu, point to Save As Other, select Reader Extended PDF, then click Enable More Tools (includes form fill in & save)…
[image: ]
22. The Enable Usage Rights in Adobe Acrobat Pro pop up window displays
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTML1577361.PNG]
23. Click the Save Now button to save the form
24. Close Adobe Acrobat Pro
[bookmark: _Toc131581903]Digitally Sign a PDF Artifact Distributed Through E-Mail with Adobe Acrobat Reader XI
NOTE: Adobe Acrobat Reader is required to digitally sign a form.
1. Display the form
2. Select the Enable All Features button in the  Protected View pop-up window if it displays
[image: ]
3. Click the  Fill & Sign button in the toolbar
[image: ]
4. Select Sign with Certificate in the Work with Certificates pane
[image: ]
5. Click the Next button in the Adobe Reader pop up window
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTML9d6cd8.PNG]
6. Place your cursor in the desired field to select it
NOTE: The first time you attempt to electronically sign a document, you will be prompted to create your digital signature. See the Error! Reference source not found. section for instructions
[image: ]
7. Click to digitally display the Sign Document dialog box
8. Click the down arrow beside the Reason field
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTML145605e.PNG]
9. Select the appropriate reason from the drop down list
[image: ]
10. Click the down arrow in the Sign As field if more than one signature resides on this device
[image: ]
11. Select the appropriate certificate from the list
[image: ]
12. Verify that the selected signature is valid
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTMLa82ed0.PNG]
13. Click the Info… button in the Sign Document window to display the details of the signature and to verify that the certificate has not expired
[image: ]
14. Click the OK button in the Certificate Viewer window
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTMLa988f0.PNG]
15. Click the Sign button
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTMLaabebf.PNG]
16. The Save As pop up window displays
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTML1587fdf.PNG]
17. Click the Save button
NOTE: The PIV card is the preferred method for digitally signing and artifact.
18. A pop up window displays requesting the password or PIN associated to the certificate
19. Enter your PIN (if using a PIV card) or password, if applicable, and click the OK button
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTMLae2fc9.PNG]
20. The digitally signed document displays
[image: ]
21. Circulate the document to all those whose signatures are required
NOTE: Whenever a team member displays the document, Adobe verifies the signatures
22. Select the icon for the Signature Panel at the top of the form
[image: ]
23. Select your signature from the Unsigned Signature Fields list in the Signatures panel
[image: ]
24. Place the cursor in the appropriate signature field
25. The next person signing the documents repeats the steps to sign the artifact
[bookmark: _Toc131581904]Digitally Sign a PDF Artifact in a SharePoint Library with Adobe Acrobat Reader XI
1. Navigate to the SharePoint Library containing the form
2. Select the form in the library
NOTE: Only one person at a time can check out the file for signing. If the file is checked out, wait for the previous signer to finish before attempting to apply your own digital signature
3. From the Open Document window, select the Check Out and Edit option then click OK
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTML16aed04.PNG]
NOTE: Do not select the Use my local drafts option. 
4. SharePoint checks out the file to you and opens the file in Adobe Acrobat Reader
5. Select the Enable All Features button in the  Protected View pop-up window if it displays
[image: ]
6. From Acrobat Reader, navigate to the document’s signature page, right-click on the arrow above your signature block, and select the Sign Document option
7. In the Sign Document box, click the Sign button
8. The ActivClient box opens
9. Type your PIN into the field and click OK and Adobe Acrobat applies a digital signature certificate from your PIV card to your signature block

Tip: The PIN for the ActivClient is the same PIN with which you log into the VA VPN daily.
10. Close the file
11. When Adobe Reader prompts you to check the file back into SharePoint, select Yes
12. In the Check In box, type Digitally signed into the Version Comments field
13. Click OK
14. Adobe saves the file and uploads it back to the SharePoint document library so that other signers can check out the file to apply their digital signatures

[bookmark: _Toc131581905]Create a Digital Signature
The first time you attempt to electronically sign a PDF file using Acrobat Reader, you will be prompted to set up your digital signature using the following steps:
1. Click the appropriate signature field
2. The Add Digital ID dialog box displays
[image: Add Digital ID dialog box ]
3. Click the New PKCS#12 digital ID file radio button
4. Click Next
5. Enter your personal information in the Add Digital ID pop up window
[image: Add Digital ID window with all fields populated ]

NOTE: Enter the name you want to appear in the Signatures tab and in any signature field that you complete and enter a corporate or organization name (if necessary) and an email address. The example shows Chris Jones for the name, Unit Name for the Organizational Unit, Organization Name for the organization name, and ChrisJones@va.gov for the email address. Ensure that you select a country/region. This example shows the default US - United States.

6. Select the default 1024-bit RSA in the Key Algorithm field
7. Select Digital Signatures and Data Encryption from the Use digital ID for drop-down list
8. Click Next
9. A new Add Digital ID pop up window displays
10. Accept the default file location or browse to your preferred location to save and safeguard your information
11. Enter a password in the Password and Confirm Password fields 

Note: Remember that the password is case-sensitive. Be sure to make a note of your password and keep it in a safe place. You cannot use or access your digital ID without this password. Your password cannot contain double quotation marks or any of the following characters: ! @ # $ % ^ & * , | \ ; < > _
[image: Add Digital ID dialog box with Password and Confirm Password fields completed]
12. Click Finish
13. Verify the location and file name in the Save As dialog box
14. Click Save
[bookmark: _Toc131581906]Add a New Digital Signature Field to a PDF in Acrobat Reader DC
1. Display the form
2. Navigate to the location in the document for the new signature
3. Select Tools from the menu bar
[image: ]
4. Select Certificates from the choices
[image: ]
5. Select Digitally Sign in the ribbon
[image: ]
6. Select the OK button in the Acrobat Reader instructional window
[image: ]
7. Click and drag to draw the area for the signature
[image: ]
8. Release the mouse to display the Sign with a Digital ID pop up window
9. Select a digital ID from the choices and verify that the selected certificate has not expired
[image: ]
10. Click the Continue button in the Sign with a Digital ID window
[image: ]
11. Click the Sign button
[image: ]
12. 	The Save As pop up window displays
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTML1587fdf.PNG]
13. Click the Save button
14. A pop up window displays requesting the password or PIN associated to the certificate
15. Enter your PIN and click the OK button
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTMLae2fc9.PNG]
16. 	The digitally signed document displays
[image: ]
17. Save the document and circulate to all those whose signatures are required

NOTE: Whenever a team member displays the document, Adobe verifies the signatures

[bookmark: _Toc131581907]Apply Digital Signatures to a Microsoft Word Document 
Microsoft Word also allows the convenient creation of documents that can be digitally signed.  Using MS Word to create and manage documents with digital signatures has the advantage of eliminating additional licensing costs.
[bookmark: _Toc131581908]Create a Form
1. Create a Word document
2. Place the cursor at the desired location for the digital signature
[image: ]
3. Select the Insert tab
[image: ]
4. Click the drop down arrow beside the Signature Line field in the Text tab
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTMLb87c08f.PNG]
5. Select Microsoft Office Signature Line… from the choices
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTMLb8a55d0.PNG]
6. Type the desired information in the fields in the Signature Setup pop up window and click to select or deselect options
[image: ]
7. Click the OK button
[image: ]
8. Repeat these steps for all signature fields you wish to create
9. Save the document
[bookmark: _Toc131581909]Distribute and Digitally Sign the Word Document through SharePoint
1. Upload the document to SharePoint
2. The signer then opens the document in read-only mode from SharePoint [image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTML24353934.PNG]

NOTE: Open the document in read-only mode. Do not check out the document or open it for editing.
3. Click the View Signatures button
[image: ]
4. Click the drop down box beside your name from the Requested signatures list in the Signatures panel
[image: ]
5. Click the Sign icon
[image: ]
6. Type your name in the signature field or, if you have a stored picture file of your signature, click Select Image… in the Sign window
[image: ]
7. Click the  Sign button
[image: ]
8. Click the Change button to select the authorized PKI (Public Key Infrastructure) signature in the Sign window
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTML1711dd3.PNG]
9. Select the authorized signature from the list in the Select Certificate window and click the OK button
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTML13f34ac.PNG]
10. Click the Sign button
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTML1356203.PNG]
11. Enter your PIN and click the OK button
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTMLae2fc9.PNG]
12. Click OK to exit the Select Certificate window
[image: C:\Users\VHAISP~1\AppData\Local\Temp\1\SNAGHTML141f1a4.PNG]
13. The digitally signed artifact displays
14. Close the document
15. The next person signing the documents repeats the exact steps 
NOTE: When everyone has signed the document from the common location it can be opened and saved to another location, but any edits to the document will invalidate all the signatures. Any changes to the document would require the approval of all the signees.
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